Characterizing the Localization Inter-dependence of Blt1p and Gef2p by Fluorescence Microscopy

Alexis D. Crayton
Advisor: John Goss
Thesis Committee Members: Louise Darling, Adam Mathews and Selwyn Cudjoe

Biological Sciences
Wellesley College
April 2017

Submitted in Partial Fulfillment of the Prerequisite for Honors in Biological Sciences

© 2016 Alexis Crayton
Acknowledgments

I am writing these acknowledgments completely humbled, as I know that the completion of this thesis is not only because of me, but also due to the hard work and support provided by my advisor, professors, Wellesley sisters, and family.

To my advisor Professor John Goss, after having taken all but one of your classes, and conducted research in your lab since the Fall of my Sophomore year, you’ve played perhaps the most important role in shaping me into a critical thinking, and thorough Biologist. You challenge me, because you know what I am capable of accomplishing. Thank you so much for guiding me through this thesis writing process, and keeping me on track with deadlines and drafts. Additionally, thank you for going above and beyond by meeting with me every week, and fully editing every part of my thesis four times over- not every thesis advisor does that, and so I am so thankful to have you as mine.

To my thesis committee members, Professor Louise Darling, Professor Adam Matthews, and Professor Selwyn Cudjoe-- thank you so much for being a part of this arduous process. In your own ways, you have each added in your valuable input, as you all wanted this thesis to be great. I am so grateful to have such a supportive committee.

To the Biology department, Chinese department, and all the other departments I joined temporarily to complete my pre-med requirements, thank you. Because of the support and devotion of too many professors to name here, I have been molded into an intersectional thinker that has been left with so many questions. I will spend my time after Wellesley trying to find the answers- thank you all for giving me the tools to start.

To Christina, Faith and Annabelle, thank you so much for continuing to believe in me. Fall semester was such a tough one for me, but you all supported me academically, and personally, and I thank you so much for that. Thank you for filling the hard times with laughter and jokes. Regarding my thesis, I don’t know if it would be complete without you all. From coming late with me to lab (sometimes as late as 12 a.m.), to offering to edit this 56-page beast, you all played an integral in making this thesis what it is. I know that it is hard to come by friends like you three, and so I am so grateful to have you in my corner, and I feel privileged to be in yours.

Lastly, to my mother, to Kristin and to my family, you all are never quite sure what I am up to, but you all always give me unrelenting support, and you make sure that I know that you are proud of me. I just want you to know that everything I do is to make you proud (and to have a sustainable, fulfilling career in the future 😊), and I will continue to strive toward that goal.
# TABLE OF CONTENTS

Abstract.................................................................................................................................3  
Introduction............................................................................................................................4  
Materials and Methods..........................................................................................................16  
Results...................................................................................................................................18  
Discussion...............................................................................................................................33  
Appendix A.............................................................................................................................40  
Appendix B.............................................................................................................................41  
Appendix C.............................................................................................................................46  
Appendix D..............................................................................................................................51  
Literature Cited.......................................................................................................................53
Abstract:

Cell division is an essential process for all living organisms, and thus, the proteins involved are often highly conserved among eukaryotes. However, many questions remain regarding the underlying mechanisms of this biological process. During cell division key signaling proteins gather and condense in ‘node’ structures at the midpoint of the cell to mark the site of future division and regulate timing of this process. Gef2p and Blt1p are two such regulatory proteins in fission yeast that localize to nodes, and are precursors of the contractile ring. Previous studies indicate that Gef2p and Blt1p are important for both mitotic entry from interphase and the spatial control of division plane placement early in cell division. Recent research suggests that Blt1p and Gef2p may have a second role later in division through contributing to initiation of contractile ring constriction by recruitment of the protein kinase Sid2p and its regulatory component Mob1p to the division site. Once localized to the contractile ring, downstream Sid2p and Mob1p mediated phosphorylation events have been implicated in initiation of contractile ring constriction and cell wall septum formation. Deletion of either Blt1p or Gef2p reduces the amount of Sid2p/Mob1p recruited to the division site and delays the onset of contractile ring constriction and completion of division.

We hypothesize that Blt1p and Gef2p independently localize to the division site. Once there, they stabilize one another, and each individually then go on to interact with and recruit Sid2p/Mob1p. Using quantitative time-lapse confocal microscopy, we characterized the localization interdependence of Blt1p and Gef2p throughout the cell cycle. Deleting blt1 reduced Gef2p localization from about 1350 molecules at the contractile ring to about 350 molecules, but gef2Δ has no impact on the amount of Blt1p recruited. Our data suggests that Blt1p may be recruiting Gef2p to the division site. A better characterization of the regulatory mechanisms controlling initiation of contractile ring constriction and completion of cell division has important implications for understanding how these processes are disrupted in a variety of cancers, neurodegenerative disorders, and other human diseases.
Introduction:

Cell division is one of the most fundamental and highly conserved cellular processes. When a cell divides, it proceeds through a sequence of events including growth, genome duplication, organelle duplication and partitioning, and subsequent division. Although cellular division and control of this process are a fundamental part of eukaryotic life, regulation of the events that occur at the end of the cell cycle, such as the reorganization of the cytoskeleton, contractile ring formation, and the initiation of cell separation, are not fully understood (Gould et. al, 1997).

Cell division requires the temporal and spatial coordination of many cellular activities. For example, during the final part of the cell cycle, a contractile actomyosin ring constricts to separate two daughter cells, and this contractile ring must be properly assembled and positioned medially to ensure equal segregation of cellular materials to each daughter cell (Guzman-Vendrell et al., 2013). Additionally, in fission yeast, the model organism utilized in these studies, a cell wall must also be constricted at the same time in this same area (Cortes et al, 2016). Since proper cell division is critical for all complex eukaryotes, proteins involved in this process are highly conserved, making it convenient to study cytokinesis in other non-human organisms (Pollard and Wu, 2010). Even though most eukaryotic cells do not form a cell wall septum, many of the proteins that regulate septation are utilized for targeting new membrane addition to the division site in higher eukaryotes, including humans (Guertin et al., 2002). Regulation of cell division is of the utmost importance for growth and development in all living organisms, and a thorough understanding of this process has great implications for medical research and human health. Misregulation of cellular division, particularly in the final stages when
the cell separates into two daughter cells, is associated with various forms of cancers, and neurodegenerative disorders in humans (Wood et al., 2002). Thus, the mechanisms behind the positioning and anchoring of the contractile ring have been the focus of intense study in recent decades.

During cytokinesis, or the final stage of cell division, the original single cell physically separates into two ‘daughter’ cells. In most eukaryotes, this physical division of the cell is accomplished using a contractile ring of proteins at the middle of the cell (Figure 1B). The ring constricts and continues to do so until it pinches the membrane together facilitating membrane fusion (through a separate pathway) which enables the cell to separate into two daughter cells (Figure 1C and 1D). This ring constriction is driven by myosin II molecular motor proteins that move along the actin filaments in an ATP dependent manner, causing the filaments to slide past one another (Glotzer, 2005). After constriction, the contractile ring disassembles, and additional cytokinetic proteins help bring together membranes of the resulting daughter cells to facilitate the final fusion step and separation (Pollard and Wu, 2010). Since proper cell division is critical for eukaryotes, proteins involved in this process are highly conserved throughout eukaryotic evolution, making it convenient to study cytokinesis in other non-human organisms (Pollard and Wu, 2010).

*Schizosaccharomyces pombe* is a popular model organism for studying many highly conserved eukaryotic processes ranging from protein trafficking and nuclear import to cell cycle regulation (Chen et al, 2004; Nurse and Thuriaux, 1980). *S. pombe* are rod shaped cells that grow through elongation at their ends (Gould et al., 1997). Upon
reaching a defined length, cells divide by binary fission at a centrally placed division site (Gould et al., 1997). In addition to its short generation period, *S. pombe* was the sixth model eukaryotic organism genome to be fully sequenced (Yanagida, 2002). This organism has 4,824 predicted genes (Yanagida, 2002). As a model eukaryote, the *S. pombe* genome shows a high degree of homology to humans, with over 50 genes coding for proteins and/or mutations found to be linked to human diseases, and nearly half of those proteins are implicated in general cancers (Wood et al., 2002). Because of this homology, the genome of *S. pombe* can be easily manipulated and the phenotypic outcome of these changes observed, which can provide insight into how various conserved processes are controlled across many eukaryotic organisms. Studies of complicated cell regulatory pathways, such as cytokinesis, in model organisms like *S. pombe* provide an opportunity to gain a better understanding of the mechanisms that regulate these processes. Insight into specific disease states carry greater implications as it could lay the groundwork for developing targeted therapies and cures in humans.

Preparation for cytokinesis occurs during interphase and is regulated by signaling platforms called ‘nodes’ (Moseley et al, 2009). For ring positioning and formation to occur, key signaling proteins accumulate around the cell equator in structures called interphase nodes, which are signaling platforms that recruit additional proteins in a tightly controlled spatial and temporal manner (Moseley et al, 2009). These key players that get recruited to the interphase nodes include many well-characterized cytokinesis regulators; however, the roles of many other proteins present in these nodes remain unknown. One of the best characterized of these is the nucleocytoplasmic shuttling protein Mid1, which plays a central role in the spatiotemporal control of contractile ring
formation (Gould et al., 1997). In *S. pombe*, proteins that contribute to the formation of the cytokinetic contractile ring accumulate in nodes during interphase (Laporte et. al, 2011). During interphase, Mid1 localizes to the nucleus and to a band of cortical nodes that are positioned in the cell middle (Guzman-Vendrell et al., 2013). Mid1p plays a role in the first of two distinct pathways that govern the positioning of the division site and the timing of ring constriction. These Mid1p-positive interphase nodes organized by a protein kinase known as Cdr2, which mediates the ordered assembly of cortical signaling nodes in the middle of the cell (Almonacid et al, 2009). This in turn negatively regulates the Wee1p, an inhibitory kinase that prevents entry into mitosis (Moseley et al., 2009).

The contractile ring is composed of filamentous actin (F-actin) and the motor protein myosin-2, along with additional structural and regulatory proteins (Miller, 2012). During interphase, F-actin is observed as cortical patches located at the polarized ends of the cell (Gould et al., 1997). But at the end of interphase before chromosome separation, a medial ring forms at the center of the cell, overlying the nucleus (Gould et al., 1997). Additional cytokinesis regulatory proteins including Gef2p, Blt1p, IQGAP protein Rng2p, myosin motor Myo2p, formin Cdc12p, and F- BAR protein Cdc15p are subsequently recruited to initiate contractile ring formation (Moseley et al., 2009; Saha and Pollard, 2012). Blt1p is implicated in stabilizing Mid1p association with cortical nodes, and Gef2p stabilizes the interaction between these two proteins (Guzman-Vendrell et al., 2013). Actin filaments generated by the actin nucleation factor formin Cdc12p within nodes and the Myo2p myosin motor proteins in neighboring nodes work in a “search, capture, pull, and release” mechanism to initiate contractile ring formation.
(Vavylonis et al., 2008). Actin filaments nucleated by Cdc12p establish a transient network between nodes where actin filaments grow in random directions parallel to the membrane (Kovar et al., 2003). Filaments that interact with Myo2p motors in neighboring nodes are stabilized, while filaments that do not bind Myo2p rapidly disassemble (Stark et al., 2010). The motor activity of Myo2p then pulls the nodes together into the contractile ring (Coffman et al., 2009). A collection of many proteins then localize to the division site, where they direct assembly of the division septum; This ring position anticipates the site of septum formation (Gould et al., 1997). The constricting ring then guides the synthesis of new cell wall by α- and β-glucan synthetases, forming a cell wall septum that ultimately bisects the cell (Simanis, 2015).

A second regulatory pathway that initiates the constriction of the newly formed contractile ring utilizes the Septation Initiation Network (SIN), a highly conserved signaling cascade (Bohnert et al., 2013). The SIN pathway prohibits polarized cell growth during mitosis and is involved in regulating anaphase spindle elongation and positioning the nuclei away from the cell division site in telophase (Rachfall et al., 2014). The protein kinases involved in the SIN signaling pathway usually reside within the microtubule organizing center [known as the Spindle Pole Body (SPB) in fission yeast], which is responsible for elongating the microtubules that comprise the mitotic spindle (Pollard and Wu, 2010). The SIN pathway begins with the activation of the GTPase Spg1p and its binding to Cdc7p (Simanis, 2015). Spg1p resides in SPBs throughout the cell cycle and remains in an inactive state during interphase until its GTPase activating protein (GAP) Byr4p-Cdc16p dissociates from the SPB (Rachfall et al., 2014). This dissociation enables
Figure 1. Basic depiction of steps involved in eukaryotic cytokinesis. Following genome segregation, the actin-myosin contractile ring (red) forms at the mid-plane of the dividing cell and constricts to pinch the cell membrane together, eventually creating two physically distinct daughter cells. Red arrow indicates a fully constricted contractile ring. Nucleus/chromosomes (purple) and microtubules (green) are also shown. Image adapted from Guertin et al, 2002.
Spg1p to adopt its active GTP bound state and initiate SIN signaling (Rachfall et al., 2014). Upon activation, Spg1p binds to the Cdc7p protein kinase, recruiting it to the SPB, where it promotes the activation of the downstream kinase Sid1p and its regulatory subunit Cdc14p via phosphorylation (Garcia and McCollum, 2009). Sid1p kinase in turn activates the Sid2p kinase and its regulatory subunit Mob1p via phosphorylation (Garcia and McCollum 2009). Active Sid2p/Mob1p is released from the SPB and localizes to the cell division site where it phosphorylates and activates the Clp1p phosphatase, which in turn dephosphorylates the F-BAR protein Cdc15p to initiate contractile ring constriction (Garcia and McCollum, 2009; Chen et al, 2008; Clifford et al, 2008). This allows the Sid2p/Mob1p kinase complex to communicate the signal that initiates contractile ring constriction and completion of cell division.

The mechanism of action involving the translocation of the Sid2p kinase to the contractile ring was unknown until recently, when three proteins were individually identified in three separate studies as potential anchors for the Sid2p/Mob1p complex at the contractile ring. Blt1p, Gef2p, and Rng2p are three node-associated proteins that are each implicated in the recruitment of Sid2p/Mob1p kinase complex to the division site (Goss et al., 2014; Zhu et al., 2013; Tebbs and Pollard, 2013). Blt1p is one of the few interphase proteins that remain consistently associated with the division site from late interphase through mitosis (Goss et al., 2014; Moseley et al., 2009). Both Blt1p and Gef2p show close genetic interactions with various cytokinetic mutants involved in septum formation, further implicating them in division site positioning and stabilization of the contractile ring (Goss et al., 2014; Zhu et al., 2013). Blt1p has been predicted to act as a scaffolding protein for precursors of the cytokinetic ring, and Blt1p and Mid1p may
provide overlapping membrane anchors for proper division plane positioning (Goss, et al, 2014; Guzman-Vendrell et al., 2013). In cells lacking Mid1p and Blt1p with functional membrane binding domains, nodes detach from the cell cortex and generate abnormal contractile rings (Guzman-Vendrell et al., 2013). During cytokinesis, Blt1p has been shown to interact with Sid2p and Mob1p, and without Blt1p contractile rings recruit and retain less Sid2p/Mob1p (Goss et al, 2014).

The guanosine nucleotide exchange factor, Gef2p is also a regulator of cytokinesis (Zhu et. al, 2013). The C terminus of Gef2p is required for Gef2p interaction with the nodes, and may interact with the N-terminus of Blt1p (Guzman-Vendrell et al., 2013). Both Blt1p and Gef2p show close genetic interactions with various cytokinetic mutants involved in septum formation, further implicating them in division site positioning and stabilization of the contractile ring (Goss et al., 2014; Zhu et al., 2013). During interphase, Blt1 interacts with Mid1 through the RhoGEF Gef2p to stabilize nodes at the cell cortex (Guzman-Vendrell et al., 2013). While Blt1p is necessary for Gef2p association with the medial cortical nodes during interphase, it has been proposed that during mitosis Gef2p localizes to the ring independently of Blt1p (Guzman-Vendrell et al., 2013; Ye, 2012). However, this proposed relationship between Blt1p and Gef2p is inconsistent with our findings in this paper. This study strives to evaluate the localization dependence of Gef2p and Blt1p upon one another for recruitment to the division site.

A third protein, Rng2p localizes to nodes and the contractile ring throughout ring formation, maturation and subsequent constriction (Tebbs and Pollard, 2013). Cells lacking either Blt1p, Gef2p, or Rng2p assemble contractile rings normally but initiate and
complete cleavage later than wildtype cells, suggesting important roles in coordinating the temporal control of cytokinesis (Goss et al., 2014; Zhu et al., 2013; Tebbs and Pollard, 2013). Previous studies have indicated that Sid2p/Mob1p recruitment is not solely regulated by Blt1p and Gef2p (Goss et al., 2014). Given the essentialness of cell division to a cell, this redundancy in function is not surprising as having multiple backups in place would ensure that division occurs. A mutated Rng2p lacking its IQ motif is known to result in normal accumulation of Bgslp at the division site, a SIN pathway regulated protein involved in the synthesis of the primary septum, but failure in the accumulation of normal amounts of Sid2p kinase and its regulatory subunit Mob1p (Liu et al., 1999; Tebbs and Pollard, 2013). It is, therefore, important to gain a better understanding of how this node protein, Rng2p, may be cooperating with one another for individual recruitment and eventual recruitment of the Sid2p/Mob1p kinase complex.

This thesis explores the relative dependence of Blt1p and Gef2p for proper localization to interphase nodes, the contractile ring, and division site, and examines the subsequent downstream effects of decreased localization on contractile ring constriction and completion of cell division. We highlight three potential ways through which Blt1p and Gef2p may coordinate with one another (Figure 2):

(1) Blt1p may first recruit Gef2p to the division site, and Gef2p could in turn could recruit the Sid2p/Mob1p kinase complex.

(2) Gef2p may be the initiating protein that recruits Blt1p, and Blt1p then recruits Sid2p/Mob1p.
Figure 2: Schematic of potential molecular interactions between Blt1p and Gef2p in recruiting Sid2p/Mob1p to the contractile ring. (A) Blt1p recruits Gef2p, and Gef2p recruits Sid2p/Mob1p. (B) Gef2p recruits Blt1p, and Blt1p recruits Sid2p/Mob1p. (C) Blt1p and Gef2p recruit one another and each independently recruit Sid2p/Mob1p to the division site. Dotted arrows represent recruitment activity.
(3) Both Blt1p and Gef2p localize to the contractile ring independently of one another and each contribute to Sid2p/Mob1p recruitment to the division site.

We hypothesize that Blt1p and Gef2p independently localize to the division site. Once there, they stabilize one another, and each individually they then go on to interact with and recruit Sid2p/Mob1p. In order to determine the recruitment pattern and level of dependence of Blt1p and Gef2p upon one another for localization to the division site, my thesis has the following aims:

(1) Generate *S. pombe* mutant strains with the combination of blt1\(\Delta\) or gef2\(\Delta\) deletion and monomeric enhanced green fluorescent protein (mEGFP)-tagged versions of Blt1p and Gef2p (blt1\(\Delta\); mEGFP-Gef2p or gef2\(\Delta\); Blt1p-mEGFP)..

(2) Utilize quantitative microscopic techniques to measure recruitment of Blt1p-mEGFP and mEGFP-Gef2p to the contractile ring in the single deletion mutants relative to wildtype.

(3) Eventually determine the role of Rng2p on Blt1p and Gef2p localization by fluorescently measuring how localization patterns to the contractile ring change in the various strains.

Through these spatial and temporal quantitative analysis techniques, we hope to elucidate the effects of Blt1p on Gef2p and vice versa, and understand how they function interdependently to localize to the division site during contractile ring formation.
Methods:

Genetic Crosses:

Combine freshly plated (<1 week) parent strains on SPA5S agar, by fully resuspending a generous amount of each strain in 50µL of deionized water. Incubate crosses at room temperature for 48-72 hours.

Tetrad Dissection:

48-72 hours after setting up the cross, cells were streaked out onto the SPA5S plate to decrease density. Add 12 microliters of deionized water to the top corner of a new YE5S agar plate, and thoroughly resuspend a small sample of cells from the diluted area on the SPA5S plate. Tilt the YE5S plate to allow the water droplet to run down the plate and distribute the cells in a line. Invert the plate onto the spore play dissection microscope and separate the four spores from each tetrad, dropping one spore at a time on the unpopulated area of the plate using the micromanipulator guides. After separating tetrads, wait 3-5 days to allow cells to replicate and grow. Replica plate the YE5S plate with tetrads onto YE5S with selection media (kanamycin (KAN) or nourseothricin (NAT) antibiotic) for screening. Strains with incorporated genetic markers should grow in appropriate selection conditions within 2 days.

Microscopy

*S. pombe* cells were incubated in 3mL YE5S liquid medium 16-24 hours at 27°C on a rotary wheel, then diluted 1:100 in YE5S and incubated at 27°C an additional 16-24 hours on a rotary wheel. Diluted cells were centrifuged at 1000xg for 1 minute and
washed three times with EMM5S media. During the final wash, 100 µL of 1M N-propyl-
gallate (NPG) was added to each sample, and following centrifugation all but 50µL or
less of the supernatant was discarded. Cells were re-suspended in the remaining liquid
and 5µL were plated on a gelatin pad (25% gelatin in EMM5S media with 0.1M NPG).

Live cell time lapse images of Blt1-mEGFP in gef2Δ or Blt1-mEGFP in gef2Δ
mutant, and Gef2-mEGFP in blt1Δ or Gef2-mEGFP in blt1Δ mutant, were acquired using
a Leica SP5 confocal microscope with a Zeiss 100x PlanApo objective at 27°C. Confocal
stacks of 14 Z-slices, 1.05 µm section thickness, and 1µm step size were taken at 3
minute intervals using 20% power from a green Argon laser and 33% power for the red
helium-neon laser. Acquisition was set at 512x512 at a speed of 100 Hz and zoom factor
of 2. Total image acquisition time duration averaged around 1.5 to 2.5 hours.

Image Analysis

Image analysis was conducted using ImageJ software and custom macros. Cells
expressing mEGFP tagged proteins were corrected for photo bleaching, background
noise, and uneven illumination before analysis of fluorescence intensity over time as
described in appendix C. A calibration curve consisting of several proteins of known
concentrations was generated for conversion of fluorescence intensity to number of
molecules, as described in result section.

Analyzing Data for Quantitative Analysis on ImageJ
See appendix B
**Results:**

Both Blt1p and Gef2p are implicated in the localization of the Sid2p/Mob1p kinase complex to the division site during cytokinesis to initiate contractile ring constriction (Goss et al., 2014). However, it isn’t clear whether Blt1p and Gef2p localize to the division site independently of one another or whether one is dependent upon the other for localization. Understanding regulation of the localization of these protein anchors will in turn provide insight into how Sid2p and Mob1p are recruited. We hypothesize that Blt1p and Gef2p independently localize to the division site. Once there they go on to recruit Sid2p/Mob1p.

**Growth assay for bltΔ and gef2Δ deletion strains**

To test the consequences of blt1Δ and gef2Δ deletions on cell viability and observe phenotypic growth disparities among strains, we conducted a growth assay at permissive (25°C), semi-permissive (30°C) or restrictive (37°C) temperatures (Figure 3). We plated various dilutions of each cell type ranging from $10^4$ to $10^1$ cells (Figure 3). Growth at the permissive and semi-permissive temperatures of 25°C and 30°C were normal between wildtype and mutant strains (Figure 3). There is a subtle growth defect for the gef2Δ strain at 37°C, but overall there was no significant change to cellular viability upon deletion of blt1 or gef2 (Figure 3).
Figure 3: *blt1Δ* and *gef2Δ* do not significantly effect cell viability. Wildtype and mutant cells (white spots) were plated at densities of $10^4$, $10^3$, $10^2$, or $10^1$ cells on YE5S agar and incubated at 25°C, 30°C, or 36°C. Cells were grown for 2 days at 30°C and 37°C; and 3 days at 25°C. Data collected and images acquired by John Goss.
Figure 4: Gef2p localization to the division site is decreased in blt1Δ mutants. Representative time course micrographs of maximum intensity projections from a confocal stack of 10 images taken of mEGFP-Gef2p (green) in (A) blt1+ or (B) blt1Δ strains or Blt1p-mEGFP in (C) gef2+ or (D) gef2Δ strains. Images were acquired at 3-minute intervals, and are shown here at 6-minute intervals. Time ‘0’ is designated as the spindle pole body duplication event (red) at the onset of anaphase A, signaling the initiation of cytokinesis.
Characterizing the recruitment of Blt1p-mEGFP and mEGFP-Gef2p to the cleavage site

To address the question of whether Blt1p and Gef2p are dependent upon one another for localization to the division site during mitosis, we utilized four *S. pombe* strains expressing genome-incorporated fluorescently tagged proteins in combination with wildtype or deleted genes of interest:

- mEGFP-Gef2p; *blt1*+
- mEGFP-Gef2p; *blt1*Δ
- Blt1p-mEGFP; *gef2*+
- Blt1p-mEGFP; *gef2*Δ

The spatial and temporal localization of Blt1p-mEGFP and mEGFP-Gef2p was characterized in wildtype or single deletion strains using timelapse confocal microscopy (Figure 4). By utilizing a ‘molecular clock’, the timing of Blt1p and Gef2p localization to the contractile ring can be quantified by setting time point zero as the moment in which the spindle pole bodies (SPB) separate at the onset of anaphase A (Wu and Pollard, 2005) (Figure 4, timepoint 0). The fission yeast protein Sad1p is thought to associate with the SPB and possibly play a role in the SPB structure (Hagan, 1995). We utilize a red fluorescently tagged Sad1p to characterize the timing of events in mitosis and cytokinesis in *S. pombe*. By establishing time zero as a reference point, the timing of the onset of ring constriction and the duration of cell division can be compared across different cells and strains. This molecular clock allowed us to temporally align the appearance and disappearance of Blt1p-mEGFP and mEGFP-Gef2p at interphase nodes, the contractile ring, and the septation site throughout the duration of cell division. Additionally, we could determine the total amount of time necessary for each sub-stage of division to be
completed for wildtype and deletion strains.

To determine whether Gef2p is dependent upon Blt1p for recruitment to the division site, we characterized Gef2p localization in the presence or absence of Blt1p (Figure 4A-B). mEGFP-Gef2p localizes in low amounts to medial nodes near the division site prior to spindle pole body separation at time 0. At 6 minutes after SPB separation, the Gef2p positive nodes coalesce into a ring, which begins to constrict at 36 minutes. Ring constriction is complete by 66 minutes and mEGFP-Gef2p dissociates from the ring at 78 minutes prior to septation and completion of cell division (Figure 4A). Alternatively, in blt1Δ cells mEGFP-Gef2p is not observed in medial nodes and is recruited to the contractile ring in low levels at 12 minutes after SPB separation. Constriction of the contractile ring is initiated at 48 minutes and completed at 78 minutes, with the final separation of daughter cells occurring at 90 minutes (Figure 4B). It is notable that some Gef2p still localizes to the division plane after formation of the contractile ring in the absence of Blt1p. This indicates that while Blt1p is important for Gef2p recruitment to the division site during the early stages of mitosis, another protein could contribute to Gef2p-mEGFP localization during cytokinesis.

To determine whether Blt1p is dependent upon Gef2p for recruitment to the division site, we characterized Blt1p localization in the presence or absence of Gef2p (Figure 4C-D). In gef2+ cells, mEGFP-Blt1p localizes in low amounts to medial nodes near the division site prior to spindle pole body separation at time 0 (Figure 4C). At 6 minutes after SPB separation, the Blt1p positive nodes localize into a ring, which
begins to constrict at 42 minutes. However, Blt1p positive nodes are also seen in more diffuse concentrations in the middle of the cell before SPB separation, during interphase (Figure 4C). Ring constriction is complete by 66 minutes and mEGFP-Blt1p dissociates from the ring at 78 minutes prior to septation and completion of cell division (Figure 4C). Alternatively, in gef2Δ cells mEGFP-Blt1p is observed in medial nodes and is recruited to the contractile ring at 6 minutes after SPB separation (Figure 4D). Constriction of the contractile ring is initiated at 42 minutes and completed at 78 minutes, with the final separation of daughter cells occurring at 84 minutes (Figure 4D). This indicates that Gef2p does not recruit Blt1p-mEGFP to the division plane during mitosis and cytokinesis. Together, these findings indicate that Gef2p is dependent upon Blt1p for localization to the division site during early mitosis and cytokinesis, but Blt1p localizes to this region independent of Gef2p (Figure 4A-D).

**Converting fluorescence intensity values into number of molecules**

We then utilized a fluorescence standard curve to quantitatively characterize how many molecules of Blt1p or Gef2p are recruited to interphase nodes, the contractile ring, and the site of septation in wildtype and mutant cells. This standard curve enables correlation of fluorescence intensity with number of protein molecules present in a given cellular region. We based our standard curve on methods developed by the Pollard lab, (Wu and Pollard, 2005). Briefly, we measured the whole cell fluorescence intensities of wildtype and six mEGFP-tagged proteins of experimentally determined cellular concentrations: Ain1p, Myo2p, Acp2p, ArpC5p, or Arp3p (Figure 5) (Wu and Pollard, 2005). By plotting the mean fluorescence intensity for each strain against its known cellular concentration and fitting the data points with a linear curve, we were able to
Figure 5: Correlation of fluorescence and molecular concentrations using a mEGFP calibration curve. To create a molecular/fluorescence correlative calibration curve we utilized five fluorescently tagged protein standards with known cellular protein concentrations. Sample micrographs are shown from five *S. pombe* strains expressing mEGFP tagged proteins and an untagged wildtype strain acquired by confocal fluorescence microscopy (n=25 cells evaluated for each strain). Images were corrected for uneven illumination and background fluorescence and the total cellular fluorescence for each strain was quantified using ImageJ (NIH) as described in Appendix C. The known total number of molecules for each fluorescent protein were plotted against the fluorescence intensity to generate a standard curve of fluorescence vs. number of molecules.
Figure 6: Gef2p recruitment to interphase nodes, the contractile ring, and the division site is dependent on Blt1p. (A) Total number of molecules of mEGFP-Gef2p recruitment to the division plane in wildtype (orange, n=20) or blt1Δ cells (blue, n=20). Asterisks indicate statistically significant difference based on two-tailed t-test, p<0.001 between time -9 to 60 minutes. (B) Blt1p-mEGFP recruitment to the division plane in wildtype (orange, n=20) or gef2Δ cells (blue, n=20). Error bars represent ±1SD.
generate an equation for calculating the number of molecules based on fluorescence intensity (Figure 5). Using this calibration curve and equation, we then could quantitatively assess the localization of Blt1p-mEGFP or mEGFP-Gef2p at the division site in wildtype or mutant cells (Figure 6).

**Quantitative assessment of Blt1p and Gef2p recruitment**

We utilized our standard curve to correlate fluorescence intensity of Blt1p or Gef2p recruited to the division site with the number of molecules in the presence or absence of the other protein. Fluorescence intensity values at the division site of wildtype, *blt1Δ*, and *gef2Δ* strains were measured for multiple cells from time-lapse movies acquired by confocal microscopy and analyzed using ImageJ. We converted the fluorescence intensity values to molecules of Blt1p-mEGFP or mEGFP-Gef2p using the standard curve (Figure 5). In *blt1+* cells, an average of 800-1000 molecules of Gef2p are present during interphase and leading up to spindle pole body separation (Figure 6A). Upon spindle pole body separation and the onset of cytokinesis, the number of Gef2p molecules at the division site increases to a maximum level of 1365± 495 molecules (Figure 6A). Upon deletion of *blt1*, we observed a drastic decrease in Gef2p localization to the division site during interphase (average of 100 molecules) relative to wildtype cells (Figure 6A). However, with the onset of cytokinesis following spindle pole body separation, Gef2p recruitment increased to a peak value of 263 ± 262 molecules at 42 minutes. The difference in the number of Gef2p molecules recruited to the division site was statistically significant between wildtype and *blt1Δ* strains at time blocks -9 minutes to 60 minutes, as indicated by the asterisk on the graph (Figure 6A).

In *gef2+* cells, an average of 2000-3000 molecules of Blt1p are present during
interphase and leading up to spindle pole body separation in (Figure 6B). Upon spindle pole body separation and the onset of cytokinesis, the number of Blt1p molecules at the division site increases to a maximum level of 3,500 +/- 1,030 molecules at time 42 minutes before dropping back down to 2,471 +/- 319 molecules by time 80 minutes (Figure 6B). Upon deletion of gef2, we observed a slight decrease in Blt1p localization to the division site during interphase (average of 1500-2000 molecules) relative to wildtype cells (Figure 6B). However, with the onset of cytokinesis following spindle pole body separation, Blt1p recruitment increased to a peak value of 2,942 +/-200 molecules at 45 minutes (Figure 6B). The difference in the number of Blt1p molecules recruited to the division site were not statistically significant between gef2+ and gef2Δ strains (Figure 6B).

Blt1p and Gef2p are implicated in recruitment of the Sid2p/Mob1p kinase complex to the contractile ring to initiate constriction and promote completion of cell division. We characterized the timing of these cellular events using fluorescence confocal microscopy to determine the effect of blt1 or gef2 deletions. Wildtype cells initiate ring constriction at 36 ± 3 minutes after spindle pole body separation, and constriction continues for 13 ± 5 minutes prior to septation and completion of cell division at 79 ± 8 minutes (Figure 7A-C). Deletion of blt1 delays the onset of contractile ring constriction to 43± 2 minutes and completion of division to 92 ± 6 minutes (Figure 7A-C). Deletion of gef2 delays the onset of contractile ring constriction to 44 ± 4 minutes and completion of division to 85 ± 5 minutes (Figure 7A-C).
Figure 7: Timing of contractile ring (CR) constriction and septation in wildtype, blt1Δ, gef2Δ, and blt1Δ/gef2Δ double mutant cells. The onset of contractile ring constriction (A), duration of ring constriction (B) and time to completion of septation (C) were characterized from wildtype, blt1Δ, gef2Δ, or blt1Δ/gef2Δ mutant cells. ≥ 25 cells were evaluated for each condition. Error bars indicate ±1 standard deviation. Data collected and imaged acquired by John Goss.
Interestingly, additional experiments done in that lab reveal that the $blt1\Delta/gef2\Delta$ double deletion strain resulted in the greatest delay for initiation of contractile ring constriction (55 ± 6 minutes), and time to completion of division and septation (139 ± 6 minutes) (Figure 7A,C). There was no significant change in the time required for constriction of the contractile ring once initiated in any mutants, indicating that the rate limiting step is initiation of ring constriction (Figure 7B).

**Creation of the rng2\Delta IQ with mEGFP-Gef2p and blt1\Delta with mEGFP-Rng2p strains**

In another study Rng2p was identified as a protein that could also contribute to Sid2p/Mob1p localization, so we wanted to determine whether Rng2p localization is dependent on either Blt1p or Gef2p (Tebbs and Pollard, 2013). The $blt1\Delta$ single deletion with mEGFP-Rng2p strain was created to characterize the role of Blt1p in the recruitment of the Rng2p to the division plane relative to wildtype. Parent strains JG1-1 ($\Delta$blt::nat) genotype strain and JG163-7C (kan-Prng2-mEGFP-Rng2;Sad1-mRFP-kan) were crossed and meiotic spores were isolated and separated for genotypic analysis (Figure 8, YE5S). After four days of growth, spores with the potential genotype of interest from rows 8 and 12 were replica plated onto Kanamycin (KAN) YE5S plates and restreaked on to Nourseothricin (NAT) YE5S plates for selection (Figure 8). Two groups of two colonies survived on both selection media (Figure 8, NAT and KAN) and were isolated as potential $blt1\Delta$ mutants with mEGFP-Rng2p. Growth on YE5S-NAT indicates deletion of $blt1$ from the genome and growth on YE5S-KAN indicates genomic incorporation of mEGFP-Rng2p. One spore was designated as ‘8A’ and the other as ‘12A’ (Figure 8,
NAT). Strains positive for mEGFP-Rng2p were confirmed by fluorescence microscopy, and deletion of *blt1* from the genome was verified by PCR.

The *rng2Δ::nat; rng2ΔIQ-leu*+ truncation mutant with mEGFP-Gef2p was created to characterize the role of Rng2p in the recruitment of the Gef2p to the division site. Parent strains kan-Pgef2-mEGFP-Gef2p; Sad1-mRFP-nat and *rng2Δ::nat; rng2ΔIQ-leu*+ were crossed and meiotic spores were isolated and separated for genotypic analysis (Figure 9, YE5S). After four days of growth, spores with the potential genotype of interest were restreaked onto YE5S-KAN and YE5S-NAT plates for selection (Figure 9). Two colonies survived on both selection media (Figure 9, NAT and KAN) and were isolated as potential *rng2Δ::nat; rng2ΔIQ-leu*+ mutants with mEGFP-Gef2p. Growth on YE5S-NAT indicates deletion of *rng2* from the genome and growth on YE5S-KAN indicates genomic incorporation of mEGFP-Gef2p. One spore was designated as ‘3D’ and the other ‘4D’ (Figure 9). Colonies 3D and 4D were then plated on EMM5S plates lacking leucine (LEU-), and growth was observed in both spore colonies indicating genomic incorporation of the *rng2ΔIQ-leu*+ truncation (Figure 9). Strains positive for mEGFP-Gef2p were confirmed by fluorescence microscopy, while deletion of *rng2* from the genome and incorporation of *rng2ΔIQ* into the genome were confirmed by PCR.
Figure 8. Generation of blt1Δ, mEGFP-rng2 strain through genetic crosses and tetrad dissection. Parent strains JG1-1 (bltΔ::nat) and JG163-7C (kan-Prng2-mEGFP-Rng2;Sad1-mRFP-kan) were crossed and 12 sets of meiotic spores were isolated and plated on YE5S growth media (white spots, top image) prior to replica plating onto YE5S-KAN and YE5S-NAT antibiotic selection media for screening (white spots center image or bottom image, respectively). Boxes and circles indicate the colonies in columns 8 and 12 with growth on both antibiotic plates.
Figure 9. Creation of \textit{rng2Δ::nat; rng2ΔIQ-leu+} truncation mutant with mEGFP-Gef2p. Parent strains JW4227 (kan-Pgef2-mEGFP-4Gly-Gef2p; Sad1p-mRFP-nat) and IN1-1 (\textit{rng2Δ::nat; rng2ΔIQ-leu+}) were crossed and 12 sets of meiotic spores were isolated and plated on YE5S growth media (white spots, top image) prior to restreaking onto YE5S-KAN, YE5S-NAT, and EMM5S-LEU, selection plates for screening (white spots top center image, bottom center image or bottom image, respectively). Circles indicate the colonies in column 5 with growth on both antibiotic plates.
Discussion:

In this study, we characterized the recruitment and inter-dependence of Blt1p and Gef2p for localization to the division plane during contractile ring formation and cytokinesis. Both Blt1p and Gef2p, have been shown to contribute to Sid2p/Mob1p localization to the division site where this kinase complex is believed to signal the initiation of ring constriction (Zhu et al., 2013). However, it is not clear whether Blt1p and Gef2p localize to the division site independently of one another or whether one is dependent upon the other for localization, and this information is important for understanding the order of events that allow for the contractile ring to form. We hypothesize that Blt1p and Gef2p independently localize to the division site, and each contributes to recruitment of Sid2p/Mob1p to initiate contractile ring constriction and completion of cell division. We proposed three possible recruitment patterns through which Blt1p and Gef2p may coordinate with one other for localization to the division site (Figure 2): (1) Blt1p may first recruit Gef2p to the division site, which in turn could recruit the Sid2p/Mob1p kinase complex; (2) Gef2p may be the initiating protein that recruits Blt1p, which then recruits Sid2p/Mob1p; or (3) Blt1p and Gef2p localize to the contractile ring independent of one another and each contribute to Sid2p/Mob1p recruitment to the division site. We set out to test these three potential localization possibilities by characterizing localization of Blt1p-mEGFP in gef2Δ cells and mEGFP-Gef2p in blt1Δ cells.

The amounts of Blt1p-mEGFP and mEGFP-Gef2p molecules present at the division site were determined by converting fluorescence intensity levels into the number of molecules by utilizing a calibration curve (Figure 5 and 6) (Wu and Pollard, 2005).
found that mEGFP-Gef2p recruitment to the division site is significantly decreased in \textit{blt1}Δ cells (Figure 4). Quantitative analysis of mEGFP-Gef2p localization to the division site in \textit{blt1}Δ mutants reveals that Gef2p localization to the division site is reduced by approximately 4-fold, with a statistically significant decrease in Gef2p localization observed between time points -9 to 63 minutes (Figure 6A). During early mitosis (-9 min) in the \textit{blt1}+ strain Gef2p molecules at the division site peak around 793± 568 molecules, where the \textit{blt1}Δ mutant contained about 92 ± 277 molecules of Gef2p at the division site near the same time point (-9 minutes) (Figure 6A). During cytokinesis, the same trend holds; at around time point 39-42 minutes (approximately the time when the contractile ring constriction begins) the number of molecules of Gef2p at the division site is around 1365± 495 in \textit{blt1}+ cells, in comparison to 263± 262 in the \textit{blt1}Δ mutants at the same time (Figure 6A). These values are consistent with findings from other groups for Gef2p localization to the division site through interphase, mitosis, and cytokinesis: in late interphase around 650 ± 280 molecules of Gef2p localize to the broad band, and about 880± 230 total molecules of Gef2p localized to the contractile ring (M. Akamatsu, personal communication, 2017). This large reduction in the amount of Gef2p recruited to the division site in \textit{blt1}Δ cells indicates that the localization of Gef2p is dependent on Blt1p. Notably, some Gef2p molecules still localize to the division site in the absence of Blt1p indicating that there may be other regulators of Gef2p that aid in its localization to the division site. Gef2p is also known to interact with Mid1p, and it is implicated in division-site and contractile-ring positioning (Munoz et al., 2014). The interaction between Gef2p and Mid1p may explain how Gef2p can still localize to the division site in \textit{blt1}Δ strains (figure 6A). Though there is presently no evidence that Gef2p interacts with
Rng2p, this protein also localizes to nodes and the contractile ring and is involved in Sid2p/Mob1p localization during cytokinesis. Therefore, we will explore whether Rng2p contributes to Gef2p localization at the division site in future studies.

Conversely, we found that Blt1p-mEGFP localization to the division site is not dependent upon Gef2p (Figure 6B). Quantitative analysis revealed that the number of Blt1p-mEGFP molecules at the division site in gef2⁺ cells was similar to localization in the mutant gef2Δ deletion mutant (Figure 6B). During early mitosis (-9 min) in the gef2⁺ strain Blt1p molecules at the division site peak at 2017 ± 667 molecules, and the peak localization at this time in the gef2Δ mutant was not significantly different (1542 ± 432 molecules) (Figure 6B). During cytokinesis, the same trend holds; at around time point 39-42 minutes, the number of molecules of Blt1p at the division site is around 3506 ± 1178 in gef2⁺ cells in comparison to 2761 ± 510 molecules in the gef2Δ mutant (Figure 6B). These values are consistent with additional studies for localization of Blt1p during interphase and cytokinesis that report around 2100 ± 820 molecules of Blt1p was localized to the broad band during interphase, and about 3000± 490 total molecules of Blt1p localized to the contractile ring (M. Akamatsu, personal communication, 2017). Thus, we found that Blt1p more profoundly influences the localization of Gef2p to the division site than Gef2p effects the localization of Blt1p. Previous studies suggest that Blt1p localization to interphase nodes is regulated by the Cdr2p mitotic kinase, and that its localization is stabilized through interactions with Mid1p (Calvert, 2009). Interestingly, both Cdr2p and Mid1p leave the division site prior to contractile ring assembly, which suggests that Blt1p is retained at the ring through interactions with other, yet to be determined proteins (Goss et al, 2014). This study finds that Gef2p is not
responsible for retention of Blt1p at the division site during late mitosis and cytokinesis.

Contrary to our hypothesis that Blt1p and Gef2p localize to interphase nodes and the division site independently of one another, our data suggests that Gef2p localization to interphase nodes, mitotic nodes, and the contraction ring is dependent upon Blt1p (Figure 4 and 6). The finding that Blt1p recruits Gef2p is consistent with possibility A proposed in Figure 2. This doesn’t rule out the possibility that Blt1p might also interact with Sid2p/Mob1p, and this should be investigated through a different set of experiments in which we evaluate the protein-protein interactions of our proteins of interest.

The time course micrograph images aligned to our “molecular clock” (based on spindle pole body separation) show a delay in total completion time of cell division in \( blt1^{\Delta} \) or \( gef2^{\Delta} \) single gene deletion strains relative to wildtype cells (Figure 4 and 7). In addition to \( blt1^{\Delta} \) and \( gef2^{\Delta} \) independently decreasing the amount of Sid2p/Mob1p at the cleavage furrow, work from our lab shows that deleting both genes has an additive effect, further reducing Sid2p/Mob1p recruitment (Goss et al., 2014). This decrease in localization of Sid2p/Mob1p in turn delays the onset of ring constriction and completion of cell division even more (Figure 7). This phenotype in the double deletion \( blt1^{\Delta}/gef2^{\Delta} \) strain, underscores the importance of having at least one of these proteins at the division plane to recruit Sid2p/Mob1p and initiate ring constriction and subsequently primary septum synthesis (Figure 7). We propose a model in which deletion of \( blt1 \) reduces localization of Gef2p to the division site by 4-fold, yet enough Gef2p is still present to recruit Sid2p/Mob1p (though it is less than in wildtype cells) and initiate contractile ring constriction (though with a delay). Likewise, in cells lacking Gef2p, Blt1p is still able to localize to the division site and recruit Sid2p/Mob1p. However, without assistance from
Gef2p, less Sid2p/Mob1p is recruited and initiation of ring constriction is delayed. The combined effect of deletion of both _blt1_ and _gef2_ leads to even less Sid2p/Mob1p recruitment since the baseline levels of Gef2p localized to the division site in _blt1Δ_ mutants is no longer present. Additional studies measuring the protein-protein interactions between Blt1p, Gef2p, Sid2p, and Mob1p are necessary to gain a better understanding of how these proteins work together to promote contractile ring constriction.

Additionally, the fact that ring constriction still occurs in the absence of both Blt1p and Gef2p indicates another protein is involved in Sid2p/Mob1p localization, possibly as a ‘backup pathway’ to ensure the success of contractile ring constriction and completion of cell division. This redundancy in function is not surprising given how essential cell division is for the cell, thus having multiple backups in place would ensure division occurs. Based on previous studies, we predict this backup mechanism is controlled by Rng2p (Tebbs and Pollard, 2013). Since Rng2p is an essential protein that is necessary for the viability of a cell, the protein cannot be deleted, but must be replaced with a truncated version or put under the control of an inducible promoter (Tebbs and Pollard, 2013). This enabled characterization of different Rng2p domains and identification of the regions that contribute to contractile formation (C-terminal half of Rng2p was identified as a critical component for the formation of the contractile ring, and the RasGAP-C domain is required for viability (Tebbs and Pollard, 2013). As cells enter mitosis, interphase nodes mature into cytokinetic nodes by recruiting contractile ring proteins through two parallel pathways, and IQGAP protein Rng2p is involved in one of these two pathways as it is recruited by Mid1p (Saha and Pollard, 2012). A mutated
Rng2p lacking its IQ motif is known to result in normal accumulation of Bgs1p at the division site, a SIN pathway regulated protein involved in the synthesis of the primary septum, but failure in the accumulation of normal amounts of Sid2p kinase and its regulatory subunit Mob1p (Liu et al., 1999; Tebbs and Pollard, 2013). Future studies in our lab will focus on understanding how Blt1p, Gef2p, and Rng2p work together to regulate Sid2p/Mob1p localization.

In preparation for evaluating whether either Blt1p or Gef2p localization are dependent upon Rng2p, or alternatively whether Rng2p localization to interphase nodes, the contractile ring, or the division plane is dependent upon Blt1p, Gef2p, or both proteins, I generated novel yeast strains with fluorescently tagged proteins of interest in each mutant background (strain list, Figure 8, Figure 9). One additional strain is needed that contains a mEGFP-rng2p and a gef2Δ to carry out these localization experiments. The novel strains developed in this study will enable use to characterize localization dynamics of Blt1p, Gef2p, and Rng2p and determine how they influence recruitment of one another to the division site, which in turn effects localization of Sid2p/Mob1p. In order to so do, we would have to determine whether the Rng2p IQ motif is interacting with Sid2p/Mob1p directly or whether it recruits Blt1p/Gef2p and they interact with Sid2p/Mob1p. We can accomplish this task through protein-binding experiments.

Gaining a more complete understanding of how proteins interact with each other and work together to regulate the formation and constriction of the contractile ring and promote successful cell division has value in terms of comprehending the complex processes controlling cytokinesis. Understanding the proteins involved, their localization hierarchy, and how recruitment to the division site is regulated allows us to better
understand how these proteins control cellular division. Moreover, understanding the pathways that regulate cell division enables the development of targeted therapies for diseases that arise when this process goes awry.
## Appendix A: Supplemental table 1: Strains Utilized in this Study

<table>
<thead>
<tr>
<th>Strain</th>
<th>Genotype</th>
<th>Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>JG3-1</td>
<td>Blt1-mEGFP-kan;Sad1-mRFP-kan</td>
<td>Lab Stock</td>
</tr>
<tr>
<td>JG117-1B</td>
<td>Blt1-mEGFP-kan;Sad1-mRFP-kan:gef2Δ::kan</td>
<td>Lab Stock</td>
</tr>
<tr>
<td>AC1-4A</td>
<td>Blt1-mEGFP-kan;Sad1-mRFP-kan;rng2Δ::nat;rng2ΔIQ-leu+</td>
<td>This Study</td>
</tr>
<tr>
<td>JW4227</td>
<td>kan-Pgef2-mEGFP-4Gly-Gef2;Sad1-mRFP-nat</td>
<td>Lab Stock</td>
</tr>
<tr>
<td>JW4237</td>
<td>kan-Pgef2-mEGFP-4Gly-Gef2;Sad1-tdtomato-nat;bltΔ::kan</td>
<td>Lab Stock</td>
</tr>
<tr>
<td>JG163-3B</td>
<td>kan-Prng2-mEGFP-Rng2;Sad1-mRFP-kan</td>
<td>Lab Stock</td>
</tr>
<tr>
<td>AC2-1A, 2B, 3C</td>
<td>kan-Prng2-mEGFP-Rng2;Sad-mRFP-kan;blt1Δ::nat</td>
<td>This Study</td>
</tr>
<tr>
<td>AC4-3D, 4D</td>
<td>kan-Prng2-mEGFP-4Gly-Gef2;Sad1-tdtomato-nat;rng2Δ::nat;rng2ΔIQ-leu+</td>
<td>This Study</td>
</tr>
<tr>
<td>JW81</td>
<td>h- ade6-M210, leu1-32, ura4-D18</td>
<td>Lab Stock</td>
</tr>
<tr>
<td>JQ1114</td>
<td>ain1-mEGFP-kanMX6, ade6-M210, leu1-32, ura4-D18</td>
<td>Lab Stock</td>
</tr>
<tr>
<td>JQ11109</td>
<td>kanMX6-Pmyo2 -mEGFP-myo2, ade6-M210, leu1-32, ura4-D18</td>
<td>Lab Stock</td>
</tr>
<tr>
<td>TP237</td>
<td>acp2-mEGFP-kanMX6, ade6-M210, leu1-32, ura4-D18</td>
<td>Lab Stock</td>
</tr>
<tr>
<td>TP347</td>
<td>aim1-mEGFP-kanMX6, ade6-M210, leu1-32, ura4-D18</td>
<td>Lab Stock</td>
</tr>
<tr>
<td>TP226</td>
<td>arpc5-mEGFP-kanMX6, ade6-M210, leu1-32, ura4-D18</td>
<td>Lab Stock</td>
</tr>
<tr>
<td>CB97</td>
<td>arp2-mEGFP-kanMX6, ade6-M210, leu1-32, ura4-D18</td>
<td>Lab Stock</td>
</tr>
</tbody>
</table>
APPENDIX B – QUANTITATIVE IMAGE ANALYSIS PROGRAMS

Analyzing Data for Quantitative Analysis on ImageJ

Load files into ImageJ
Option 1: Drag an image or collection of images onto the main ImageJ toolbar and drop them.
Option 2: Go to the ‘File’ menu, then ‘Import’ → ‘Image Sequence.’ Designate the path to direct the program to where the folder or image(s) are saved. This option works best when you are opening multiple images at the same time.
   - This option also provides you with options for how you would like the images to be loaded (as individual windows or sequentially within the same window)

Rotate an image
(1) Go to the ‘Image’ drop down menu and choose ‘Transform’ → then select the type of rotation you prefer.
(2) To designate a particular angle of rotation, choose “Rotate…” and a window will pop-up.
   a. Choose the angle of rotation in degrees (keeping gridlines and Bilinear Interpolation as they are) and click the boxes next to ‘Enlarge Image to Fit Result’ and ‘Preview’ to sample any rotations before they are saved.
   b. Click ‘OK’ to accept the image rotation.

Convert a 3-dimensional stack of images into a 2-dimensional image
For a single time point:
(1) Load images into ImageJ as described above; all images from the Z-stack should load in a single window. You can scroll through the Z-stack using the scroll bar at the bottom.
   a. If they load as individual images, go to ‘Images’ → ‘Stacks’ → ‘Images to Stack’
   b. The pop-up window will ask you to name the stack and whether you want to keep the source images – you typically don’t need to do either. Click the ‘OK’ button.
(2) Go to ‘Image’ → ‘Stacks’ → ‘Z-project…’
(3) In the pop-up window, the program will determine the ‘Start slice’ and ‘Stop slice.’ You need to determine the ‘Projection type.’
   a. Average Intensity – takes the average intensity of each pixel in the image at each slice of the Z-stack. This is good for making images you can use in figures or presentations, but not for data analysis.
   b. Max Intensity – take the brightest x/y pixel from each slice of the Z-stack and uses that for the final image. This is good for making images you can use in figures or presentations, but not for data analysis.
   c. Min Intensity – opposite of Max Intensity. Not really useful for what we do.
d. Sum slices – this is best for analysis of 3-D data sets because it just sums the fluorescence from each slice – thus the total fluorescence in your resulting 2-D image represents the true sum intensity of the images.

e. Standard Deviation and Median – not really useful for what we do.

(4) Be sure the ‘All time frames’ box is checked, then click the ‘OK’ button.

(5) The resulting image is a 2-D representation of your data through time – you can use the scroll bar to move along through the timepoints.

(6) Adjust your image ‘Brightness/Contrast’ as necessary (see above).

For multiple time points:

(1) Load images into ImageJ as described above; all images should load as a single stack.

(2) Go to ‘Images’ → ‘Hyperstacks’ → ‘Stack to Hyperstack…’

(3) In the pop-up window, use the default Order: xyczt (default)

(4) Designate the number of channels, slices, and frames – this information should all be available in the metadata for each data set.

   a. Channels = number of colors you acquired (GFP, RFP, etc…)
   b. Slices = number of Z-slices from the 3-D acquisition
   c. Frames = number of timepoints
   d. Multiplying these three values should give the total number of frames

(5) I prefer to work with the images in ‘greyscale’ mode rather than ‘color’

(6) Your image is now in a hyperstack where you can sort through the Z-slices or the time points using different scroll bars. You will need to delete 4 slices in total, preferably two slices from each side.

(7) Go to ‘Images’ → ‘Stacks’ → ‘Z-Project…’

(8) In the pop-up window, the program will determine the ‘Start slice’ and ‘Stop slice.’ You need to determine the ‘Projection type.’

   a. Average Intensity – takes the average intensity of each pixel in the image at each slice of the Z-stack. This is good for making images you can use in figures or presentations, but not for data analysis.
   b. Max Intensity – take the brightest x/y pixel from each slice of the Z-stack and uses that for the final image. This is good for making images you can use in figures or presentations, but not for data analysis.
   c. Min Intensity – opposite of Max Intensity. Not really useful for what we do.
   d. Sum slices – this is best for analysis of 3-D data sets because it just sums the fluorescence from each slice – thus the total fluorescence in your resulting 2-D image represents the true sum intensity of the images.
   e. Standard Deviation and Median – not really useful for what we do.

(9) Be sure the ‘All time frames’ box is checked, then click the ‘OK’ button.

(10) The resulting image is a 2-D representation of your data through time – you can use the scroll bar to move along through the time points.

(11) Adjust your image ‘Brightness/Contrast’ as necessary (see above).
**Loading the Z-stack into Image J:**
Option 1: Drag a Z-stack (collection of images) onto the main ImageJ toolbar and drop them.
Option 2: Go to the ‘File’ menu, then ‘Import’ → ‘Image Sequence.’ Designate the path to direct the program to where the folder or images are saved. This option works best when you are opening multiple images at the same time.

- This option also provides you with options for how you would like the images to be loaded - you want them sequentially within the same window.

**Preparing the ‘background correction’ Image:**
1. Load the background fluorescence Z-stack images into Image J as described above: all images from the Z-stack should load as a single window.
   a. If they load as individual images, go to ‘Images’ → ‘Stacks’ → ‘Images to Stack’
   b. The pop-up window will ask you to name the stack and whether you want to keep the source images – you typically don’t need to do either. Click the ‘OK’ button.
2. Go to ‘Image’ → ‘Stacks’ → ‘Z-project’
3. In the pop-up window, the program will determine the ‘Start slice’ and ‘Stop slice.’ You need to set the ‘Projection type’ to ‘Sum slices.’ Click the ‘OK’ button.
4. The resulting image is a 2-D representation of the background from the optical system. This image is now ready to use for correcting your data. You can save this image in the present form so that you won’t have to go back through these steps every time you need a background correction image.
   1. ‘File’ → ‘Save As’ → ‘Tiff’

**Preparing the ‘uneven illumination’ image:**
1. Load the uneven illumination Z-stack images into Image J as described above; all images from the Z-stack should load as a single window.
   a. If they load as individual images, see 1.a.
2. Go to ‘Image’ → ‘Stacks’ → ‘Z Project’
3. In the pop-up window, the program will determine the ‘Start slice’ and ‘Stop slice.’ You need to set the ‘Projection type’ to ‘Average Intensity.’ Click the ‘OK’ button.
4. The resulting image is a 2-D representation of the non-normalized uneven illumination from the optical system.
5. Select the entire field by clicking on the window with the uneven illumination image, then press ‘ctrl+A’. A yellow box should surround the field of view.
6. Determine the maximum intensity point on the image by pressing ‘ctrl+M’ or going to ‘Analyze’ → ‘Measure’
7. In the pop-up ‘Results’ window, record the ‘Max’ value
   a. If the ‘Max’ value doesn’t show up, go to ‘Analyze’ → ‘Set Measurements’ and check the box for ‘Min & max grey values’ then repeat steps 5-6 above
8. Go to ‘Process’ → ‘Math’ → ‘Divide’
   a. In the pop-up window, enter your recorded ‘Max’ value from step 7 in the ‘Value’
blank. Click the ‘OK’ button.

9. This gives you a normalized uneven illumination image where the maximum intensity is 1 and every other pixel is some fraction of that. This image is now ready to use for correcting your data. You can save this image in the present form so that you won’t have to go back through these steps every time you need an uneven illumination image.

1. ‘File’ → ‘Save As’ → ‘Tiff’

**Correcting your data set for quantitative analysis:**

1. To subtract the background from your data set, go to ‘Process’ → ‘Image Calculator’
   a. For ‘Image 1’ select your previously loaded data set
   b. For ‘Operation’ select ‘Subtract’ form the drop down menu
   c. For ‘Image 2’ select the image you generated above for the background correction.
   d. Be sure the boxes are checked for ‘Create new window’ and ’32-bit (float) results’
   e. Click the ‘OK’ button

2. To correct for uneven illumination of your data set, go to ‘Process’ → ‘Image Calculator’
   a. For ‘Image 1’ select the data set that has already been corrected for background
   b. For ‘Operation’ select ‘Divide’ from the drop down menu
   c. For ‘Image 2’ select the image you generated above for the uneven illumination
   d. Be sure the boxes are checked for ‘Create new window’ and ’32-bit (float) results’
   e. Click the ‘OK’ button

This image is now completely corrected and normalized. You can save the image sequence so that if you need to come back to it later you won’t have to go through the corrections again.

1. ‘File’ → ‘Save As’ → ‘Tiff’

**Correcting time series data for photobleaching**

1. Designate a region of a cell that is not relevant for your data collection (if you are measuring the fluorescence intensity of the contractile ring, choose a region of the cell at the poles where the fluorescence levels are low and don’t change much over the length of your movie)
   a. Choose the ‘oval/elliptical’ tool from the Image J toolbar and draw a small circle
   b. Place the circle in designated region of the cell and press ‘ctrl+M’ to measure the fluorescence in this region
      i. Profess through the movie and do this for every frame- be sure you remain
         within roughly the same place in the cell throughout
         1. If a bright fluorescent structure moves into the region of interest
            move to a different (but close) part of the cell to continue
   c. Enter the fluorescence intensity values from each timepoint into an Excel
spreadsheet—this represents your photobleaching timecourse data

i. Divide all the observed values by the largest value to normalize to 1.
d. Repeat steps a-c for 9 more cells, such that you have photobleaching data for 10 cells total.
e. Average the normalized values (from part c.i. above) for each of the 10 data sets to get the normalized photobleaching data. This will be used to correct your images for photobleaching after you collect the data in your region of interest

**Quantitative Fluorescence Data Acquisition**

1. Choose the cell that you want to analyze and draw a rectangle around it. Press ‘ctrl+shift+D’ to duplicate that region of interest into a new stack that you can work with. Click ‘OK’ when asked to duplicate stack.

2. If you are looking at the contractile ring, rotate the image until the ring is perpendicular to the window. ‘Image’ → ‘Transform’ → ‘Rotate’ then try different angles of rotation until you find the best one.

3. Designate your region of interest within a cell by drawing a circle or rectangular region of interest.

4. Catalog the x-y-time position of this ROI by pressing ‘ctrl+t’

5. Move forward through time (using the comma and period key) and record coordinates for each by continuing to press ‘ctrl+t’

6. ‘Plugins’ → ‘macros’ → ‘Install’
a. Select the ‘BackRingSub’ file

7. ‘Plugins’ → ‘macros’ → ‘Run’
a. Select the ‘BackRingSub’ file

8. Measure fluorescence intensity for every time point.

9. Using the data collected, plot the fluorescence intensity against the time on an Excel spreadsheet
### APPENDIX C – RAW DATA FROM TIMELAPSE MICROSCOPY

Blt1-mEGFP-kan;Sad1-mRFP-kan
Blt1-mEGFP-kan;Sad1-mRFP-kan;gef2Δ:kan
| A | B | C | D | E | F | G | H | I | J | K | L | M | N | O | P | Q | R | S | T | U | V | W | X | Y | Z |
| 1 |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 2 |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 3 |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 4 |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 5 |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 6 |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 7 |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 8 |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 9 |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 10|   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 11|   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 12|   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 13|   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 14|   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 15|   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 16|   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 17|   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 18|   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 19|   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 20|   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 21|   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 22|   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 23|   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 24|   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 25|   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 26|   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 27|   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 28|   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 29|   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 30|   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 31|   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 32|   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 33|   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 34|   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 35|   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |
| 36|   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |   |

**Figure 1:** Graph showing the relationship between various factors and results. **Data Table:** Table with columns A to Z and rows 1 to 36. **Diagram:** Graph displaying data trends.
kan-Pgef2-mEGFP-4Gly-Gef2;Sad1-tdtomato-nat;bltΔ::kan
<table>
<thead>
<tr>
<th></th>
<th>Average</th>
<th>StDev</th>
<th>Mean Molec Corrected Fluorescence</th>
</tr>
</thead>
<tbody>
<tr>
<td>wildtype</td>
<td>JW81</td>
<td>11560.7228</td>
<td>2993.75201</td>
</tr>
<tr>
<td>Arp3</td>
<td>CB97</td>
<td>127491.706</td>
<td>15529.75</td>
</tr>
<tr>
<td>Myo2</td>
<td>JQ1109</td>
<td>22993.5666</td>
<td>4192.96082</td>
</tr>
<tr>
<td>Ain1</td>
<td>JQ1114</td>
<td>23161.465</td>
<td>2512.49131</td>
</tr>
<tr>
<td>ArpC5</td>
<td>TP226</td>
<td>67067.2673</td>
<td>8541.74404</td>
</tr>
<tr>
<td>Acp2</td>
<td>TP237</td>
<td>35796.3338</td>
<td>5800.02118</td>
</tr>
</tbody>
</table>

mEGFP Calibration Curve

\[ y = 1.7227x \]

\[ R^2 = 0.98483 \]
APPENDIX D– RECIPES FOR GROWTH PLATES AND MEDIA

**YE5S Liquid Growth Media (yeast)**

- 5g of yeast extract
- 30g dextrose
- 0.225g amino acids
- Adenine o Histidine o Leucine o Lysine
- Uracil
- 1L deionized water

**YE5S Plate Growth Media (yeast)**

- 5g of yeast extract
- 30g dextrose
- 0.225g amino acids
- Adenine o Histidine o Leucine o Lysine
- Uracil
- 18g Bacto Agar
- 980 mL deionized water

**Sodium glutamate (SPA5S) Plate**

- 0.225g amino acids o Adenine
- Histidine o Leucine o Lysine
- Uracil
  - 1g potassium phosphate monobasic
  - 10g dextrose
  - 30g agar
  - 990 mL ddH2O

**EMM5S Plate Growth Media**

- 0.225g amino acids o Adenine
- Histidine o Leucine o Lysine
- Uracil
- 3g potassium hydrogen phthalate
- 2g sodium phosphate dibasic
- 5g ammonium chloride
- 20mL salt solution
- 1mL vitamin stock solution
- 100uL minerals solution
- 100mL 20% dextrose (prepared and autoclaved separately)
- 20g agar
- 870mL of ddH2O

**Blue Buffer Lysate Solution**

- 224.5 mL H2O
- 5 mL 100% of 2% Triton-100
- 12.5 mL 20% of 1% SDS
- 5 mL 5M of 100 mM NaCl
- 2.5 mL 1M of 10 mM Tris pH 8.0
- 0.5 mL 0.5M EDTA of 1mM EDTA
References:


Guzman-Vendrell, Merce; Baldissard, Suzanne; Almonacid, Maria (2013). Blt1 and Mid1 Provide Overlapping Membrane Anchors To Position the Division Plane in Fission Yeast. Molecular and Cellular Biology, 33(2), 418-428


